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Chapter 1 — About This Guide

Overview
This document has eight major sections:

Chapter 2 — Introduction to the First Maintenance Release on page 3

Chapter 3 — Pre-Installation Instructions on page 5

Chapter 4 — Installation Instructions on page 7

Chapter 5 — Post-Installation Instructions on page 13

Chapter 6 — Validation Instructions on page 19

Chapter 7 — Installing the First Maintenance Release on page 25

Chapter 8 — Performing Common Tasks on page 27

Chapter 9 — Unconfiguring SAS Offer Optimization for Communications on page 35

Prerequisites

Before you start with the installation, see Systems Requirements—SAS Offer Optimization for
Communications 5.2 for information about third-party software and operating system

specifications. This document is available at the following location:
http://support.sas. conf docunentation/installcenter/en/ikbppofrsr/ 64086/
PDF/ def aul t/ sreq. pdf.

Technical Support

Please visit the SAS Technical Support Web site, ht t p: / / support. sas. com for installation
updates.

For product documentation, please visit the SAS Technical Support Documentation Web site
http://support.sas. conf docunent ati on/onli nedoc/i ndex_of feropt. htmnl .

Note to the reader:

Words in examples that are enclosed in < (less than) or > (greater than) symbols are meant to be
replaced by information from your system.

For example, <SAS i nstal | ati on pat h> should be replaced by the path where you installed
SAS. If you installed SAS in Program Files on your D drive, then replace <SAS i nstal | ati on
pat h> with D: / Program Fi | es/ SAS.

<SASconfiguration path>should be replaced by the path where your configuration is
installed. If you installed the configuration on / opt path and used a configuration name of
Conf i g, then replace <SAS confi gurati on path>with/opt/ SAS/ Confi g.
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Chapter 2 — Introduction to the First Maintenance Release

Upgrading to the First Maintenance Release

This document gives you guidelines to upgrade to the first maintenance release of SAS Offer
Optimization for Communications 5.2. The steps that you have to perform in order to complete
the upgrade depend on whether you have completed the SAS Offer Optimization for
Communications 5.2 installation and configuration.

When you plan for your SAS Offer Optimization for Communications 5.2 installation, you have
to consider the following scenarios:

Scenario 1: Upgrade-in-Place

SAS Offer Optimization for Communications 5.2 is already installed and configured on your
machine. In this scenario, you have to complete the instructions that are detailed in Chapter 8 of
this document.

Scenario 2: Fresh Installation

SAS Offer Optimization for Communications 5.2 is not installed on your machine. Therefore, in
this scenario, you have to first complete the instructions that are detailed for SAS Offer
Optimization for Communications 5.2 installation and configuration. These instructions are
detailed in Chapters 3 through 6 of this document.

Flowchart for the First Maintenance Release Installation

The following flowchart summarizes the scenarios in which you can install the first maintenance
release of SAS Offer Optimization for Communications 5.2. In addition, this flowchart indicates
the chapters that you need to refer to complete the installation.

Page 3
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Chapter 3 — Pre-Installation Instructions

Setting Up the Oracle Database

The following subsections explain the procedures that you have to complete in order to set up the
Oracle database. You must set up the Oracle database before you install SAS Offer Optimization
for Communications 5.2 by using the SAS Deployment Wizard.

Prerequisites

Before you set up the Oracle database, make sure that you have completed the following
instructions:

1. Install Oracle database software (Oracle Database 11g Standard Edition or Oracle Database
11g Enterprise Edition) on the Data server.

2. Create a database instance with an appropriate listener service entry. This guide refers to the
listener service entry as “OOC.”

3. Install Oracle 11g ODAC (Oracle Data Access Components) software on the server-tier
machine.

4. Create a listener service entry named OOC on the server-tier machine, by using Oracle Net
Configuration Assistant. The listener service entry should point to the OOC database
instance that is created on the Data server.

Set Up the OOC Oracle Database

To set up the OOC Oracle database, complete these steps with the profile of an Oracle super user
or system user:

1. Log on to the OOC database instance from the data-tier or server-tier machine. To do so,
complete these steps:

a. Go to the command prompt.
b. Typesql pl us <system user name>/ <syst em passwor d>@0OC as sysdba.

2. At the SQL prompt, create the OOC Oracle users and schemas using the following set of
commands.

Note: In the following commands, replace <User Passwor d> with the actual password string.
Also, make sure that you use the same user name or schema name as mentioned in the
commands listed below.

SPOOL <l og fil ename>

CREATE USER REF | DENTI FI ED BY <REF Passwor d>;
GRANT CONNECT, RESOURCE TO REF;

CREATE USER DI M | DENTI FI ED BY <DI M Passwor d>;
GRANT CONNECT, RESOURCE TO DI M

CREATE USER FACT | DENTI FI ED BY <FACT Passwor d>;
GRANT CONNECT, RESOURCE TO FACT;

CREATE USER M SC | DENTI FI ED BY <M SC Passwor d>;
GRANT CONNECT, RESOURCE TO M SC;

CREATE USER BASE | DENTI FI ED BY <BASE Passwor d>;
GRANT CONNECT, RESOURCE TO BASE;

CREATE USER DABT_ADM | DENTI FI ED BY <DABT_ADM Passwor d>;
GRANT CONNECT, RESOURCE TO DABT_ADM
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CREATE USER BPPAPTBL | DENTI FI ED BY <BPPAPTBL Passwor d>;
GRANT CONNECT, RESOURCE TO BPPAPTBL;

CREATE USER BPPI NF | DENTI FI ED BY <BPPI NF Passwor d>;
GRANT CONNECT, RESOURCE TO BPPI NF;

CREATE USER BPPEXEC | DENTI FI ED BY <BPPEXEC Passwor d>;
GRANT ALL PRI VI LEGES TO BPPEXEC,

SPOCL OFF

EXIT

3. Open the log file that is created after you complete step 2. Make sure that the log file does not
contain any errors.

Note: The log file is created in the physical directory from where you launch SQLPLUS.

Configure the ORACLE_HOME and the Shared Library Path Variables

When you install SAS Offer Optimization for Communications using the SAS Deployment
Wizard, SAS/ACCESS Interface to Oracle is used to create tables. In order to complete this task
successfully, you must configure the ORACLE_HOME and the shared library path variable. For
details, see "Setting the ORACLE_HOME Variable" in Configuration Guide for SAS 9.2 Foundation

for UNIX Environments. This guide is available at the following location:
http://support.sas. coni docunentation/installcenter/en/ikfdtnunxcg/ 61994
/ PDF/ def aul t / confi g. pdf.


http://support.sas.com/documentation/installcenter/en/ikfdtnunxcg/61994/PDF/default/config.pdf
http://support.sas.com/documentation/installcenter/en/ikfdtnunxcg/61994/PDF/default/config.pdf

Chapter 4 — Installation Instructions

Overview

This section provides instructions to install SAS Offer Optimization for Communications on a
single physical server along with SAS 9.2 Enterprise Intelligence Platform.

Getting Started

Before you begin with the installation, complete these steps:

1.

3.

Refer to SAS 9.2 Intelligence Platform: Installation and Configuration Guide. This guide is
available at the following location:
http://support.sas. conl docunent ati on/ cdl / en/ bii g/ 60946/ PDF/ def aul t/ bii g. pdf.

Download your software into a SAS Software Depot that is accessible to all machines on
which you want to complete the installation.

Copy your plan files to a suitable location, such as <SAS pl an file path>/plan. xm

Install SAS Server Software and SAS Offer Optimization for
Communications

To install SAS Offer Optimization for Communications and other relevant SAS products by using
the SAS Deployment Wizard, complete these steps:

1.

Start the SAS Deployment Wizard.

Note: By default, the SAS Deployment Wizard for SAS Offer Optimization for Communications has
multiple managed servers. For a Typical installation, the SAS Deployment Wizard enforces
multiple managed servers. However, for a Custom installation, it is recommended that you do
not deselect the Multiple Managed Server check box.

Refer to Using Version 9.2 of the SAS Business Intelligence Platform to Assign Unique SAS
Application Servers to SAS Offer Optimization for Communications: Technical Paper, which is
available at the following location:

http://support.sas. conl docunent ati on/ onli nedoc/i ndex_offeropt. htm .
This technical paper provides installation instructions for a clean installation and an up-sell
scenario installation. Choose the correct scenario and follow appropriate instructions
according to your installation requirements.

Note: Perform step 3 when you reach the first screen of the SAS Deployment Wizard that enables you
to configure SAS Offer Optimization for Communications.

Enter the following details for SAS Foundation for Communications Server Configuration
Database Configuration.

Field name Description

Host name Enter the database server name. For example, the database server name can
bedbserver01. abc. com

Port number Review the port number on which the database services are running.

User name Displays BPPEXEC as the value for the database user. Y ou cannot change
this value.

Password Enter the appropriate password for the above user name.

Confirm Password Enter the same password again, and then click Next.
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4. Enter the following details for SAS Foundation for Communications Server Configuration

Oracle Configuration.

Field name

Description

Oracle Service name

Enter the service name for your Oracle database. The default
service nameis OOC.

Listener service connection
name

Enter the listener service connection name that is created as
mentioned in the pre-installation instructions in this guide. The
default service connection name is OOC.

Click Next.

5. Enter the following details for the REF and DIM schemas.

Field name

Description

REF schema user name

Displays the user name of the REF schema. Y ou cannot change
this value.

REF schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again.

DIM schema user name

Displays the user name of the DIM schema. Y ou cannot change
thisvalue.

DIM schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.

6. Enter the following details for the BASE and FACT schemas.

Field name

Description

BASE schema user name

Displays the user name of the BASE schema. Y ou cannot change
thisvalue.

BASE schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again.

FACT schemauser name

Displays the user name of the FACT schema. Y ou cannot change
thisvalue.

FACT schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.

7. Enter the following details for the MISC schema.

Field name

Description

MISC schema user name

Displays the user name of the M1SC schema. Y ou cannot change
thisvalue.

MISC schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.
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8. Enter the following details for the BPPAPTBL and DABT_ABT schemas.

Field name

Description

BPPAPTBL schema user name

Displays the user name of the BPPAPTBL schema. Y ou cannot
change this value.

BPPAPTBL schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again.

DABT_ADM schema user
name

Displays the user name of the DABT_ADM schema. Y ou cannot
change this value.

DABT_ADM schema user
name

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.

9. Enter the following details for the BPPINF schema.

Field name

Description

BPPINF schema user name

Displays the user name of the BPPINF schema. Y ou cannot
change this value.

BPPINF schema password

Enter the appropriate password for the above user name.

Confirm Password

Enter the same password again, and then click Next.

10. In the SAS Offer Optimization for Communications Mid-Tier: JDBC Jar file dialog box,
specify the complete path where your JDBC jar file is located.

11.

Note: Make sure that you select the [DBC jar file from the user Oracle installation directory, which is
$ORACLE_HOVE/ sql devel oper/jdbc/ | i b. It is recommended that you should not
select the jar file from any other location. Otherwise, you might encounter errors when you start
working with the SAS Offer Optimization for Communications interface.

Click Next.

Note: If you are installing in the UNIX environment, then you will not be able to proceed further
until you complete the instructions that are detailed in step 12.
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12. Perform this step only for a UNIX installation.

If you are installing the SAS products on a UNIX machine, you might be prompted with the
Insufficient Permissions message window.

S Insufficient Permissions

Perform the following steps at the UNIX prompt:
a. Go to the ! SASROOT/ sasexe/ directory.

b. Create a backup of the sasora file by entering the following command:
mvy sasora sasora_orig

c. Create a symbolic link to the correct SAS oracle image for Oracle 11g (or any other
version as appropriate). For details, see “Setting Up the Symbolic Link” under
“SAS/ACCESS Interface to Oracle Software” in the Configuration Guide for SAS 9.2

Foundation for UNIX Environments. This guide is available at the following location:
http://support.sas. conf docunentation/installcenter/en/ikfdtnunxcg
/ 61994/ PDF/ def aul t/ confi g. pdf

d. Confirm that all the dynamic library links are resolved by entering the following
command:

UNI X _pronpt> | dd sasora

e. Run the set ui d. sh script as root. For details, see the information that is mentioned in
the Insufficient Permissions message window.

f.  Return to the Insufficient Permissions message window and make sure that you click
Retry.
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13. Click Finish to close the SAS Deployment Wizard after you complete the installation.

Note: SAS Offer Optimization for Communications is deployed on Managed Server SASServer11l
according to your application server. Check whether this server is running. If it is not running,
then start it manually from the appropriate application console.

11
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Chapter 5 — Post-Installation Instructions

Overview
The post-installation instructions are categorized based on the following components:
1. Foundation data mart
2. Customer analytics
3. SAS Offer Optimization for Communications application
Make sure that you perform the instructions in the sequence that is mentioned above.
Note:

e In order to work with the SAS Offer Optimization for Communications application,
perform the instructions that are detailed for steps 1, 2, and 3.

¢ If you want to work with Customer Analytics, then perform the instructions that are
detailed for steps 1 and 2.

e If you want to configure the Foundation data mart only, then perform the instructions
that are detailed for step 1.

Create User in SAS Management Console

The user who executes the INSERT scripts that are mentioned in the instructions below needs
access to the libraries that are predefined in the SAS environment. In order to enable the user to
have this capability, you have to define this user in SAS Management Console.

To define the user who will execute the INSERT scripts, complete these steps:
1. Log on to SAS Management Console with the default profile of sasadm user.
2. Define the user with the following access permissions:

¢ Role: Metadata Server: Unrestricted

¢  Group: Communication Common Oracle User Group

3. Close SAS Management Console.

Step 1: Instructions for Foundation Data Mart

This section explains the post-installation instructions for the Foundation data mart.

Define Permissions for Data and Logs Folders

You must grant full permissions to the default user, sassrv, who will access the data that is
populated in the Foundation data mart.

Depending on the operating system of your machine, use appropriate commands to grant all
permissions to the sassrv user for the following folders:

<SAS configuration path>/Levl/ Appli cati ons/ SASFoundf or Cormb. 2/ Dat a
<SAS configuration path>/ Levl/ Applications/ SASFoundf or Cormb. 2/ Logs

Page 13
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Update and Run INSERT Scripts

The INSERT scripts for the Foundation data mart insert appropriate values into format and
parameter tables that are required for running ETL jobs in the Foundation data mart.

To update and run INSERT scripts, complete these steps:

1.

5.
6.
7.
8.

Go to the <SAS configuration pat h>/Levl/ <SAS Application Server context
nane> folder.

Depending on whether the operating system is Windows or UNIX, run the sas. bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C. / SAS/ Confi g/ Levl/ SASOOC/ sas. bat file.

Opentheal | _confdn_dat a_i nserts. sas macro. This macro is located in the following

folder:
<SAS configuration path>/Levl/ SASApp/ SASEnvi r onment /

SASFoundFor Conmb. 2/ SASCode/ i nsertscri pts.
Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.
b. Specify the value, MISC, for the SCHEMA parameter.
c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the MISC schema in the procedure block and also change the
pwfile path according to your environment.
proc pwencode in='BPPEXEC out=pwiile;
run,

e. Specify the <SAS confi gurati on path>/Levl/ SASApp/ SASEnvi r onment /
SASFoundFor Commb. 2/ SASCode/ i nsert scri pts value for the scripts_root
parameter.

Click Save.

Click Run.

To ensure successful execution of the INSERT scripts, select View = Log on the menu.
Close Base SAS.

Step 2: Instructions for Customer Analytics

This section explains the post-installation instructions for the analytical components of SAS Offer

14
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Create User for SAS Enterprise Miner

Analytical models for customer retention and customer segmentation are created using SAS
Enterprise Miner. Therefore, you must create a dedicated external user ID, which can be used for
creating projects and developing analytical models in SAS Enterprise Miner.

To create a user for SAS Enterprise Miner, complete these steps:

1. Open SAS Management Console with the default profile of sasadm user.
2. Select the Plug-ins tab.

3. Expand Environment Management.

4

Right-click User Manager and select New = User. The New User Properties dialog box
appears.

5. Select the General tab.
a. Enter the appropriate name and description of the user.
b. Click OK.

6. Select the Groups and Roles tab.

a. Select Metadata Server: Unrestricted from the Available Groups and Roles list and
move it to the Member of list.

b. Select SAS System Services from the Available Groups and Roles list and move it to the
Member of list.

c. Click OK.
7. Select the Accounts tab.
a. Click New. The New Login Properties dialog box appears.
b. Enter appropriate User ID and Password.
c. Select DefualtAuth as the Authentication Domain.
d. Click OK.
8. Close SAS Management Console.

Define Permissions for Data and Logs Folders

You must grant full permissions to the dedicated user that you create for performing tasks in SAS
Enterprise Miner.

Depending on the operating system of your machine, use appropriate commands to grant all
permissions to the user for the following folders:

<SAS configuration
pat h>/ Levl/ Appli cati ons/ SASCf f er Opt For CormSer ver 5. 2/ Dat a

<SAS configuration
pat h>/ Levl/ Appl i cati ons/ SASCf f er Opt For CormSer ver 5. 2/ Logs

15
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Update and Run INSERT Scripts

The INSERT scripts for the customer analytics component insert data into Analytical
Configuration Tables.

To update and run INSERT scripts, complete these steps:

1.

® N o @

Go to the <SAS configuration pat h>/Levl/ <SAS Application Server context
name> folder.

Depending on whether the operating system is Windows or UNIX, run the sas. bat or the
sas. sh file respectively. For example, on the Windows machine, run the

C. / SAS/ Confi g/ Levl/ SASOOC/ sas. bat file.

Note: A few error messages might be displayed when you run the sas. bat or the sas. sh file.

These errors occur because the required data sets are not available in the <SAS
configuration
pat h>/ Lev1/ Appl i cati ons/ SASO f er Opt For CommSer ver 5. 2/ Dat a/ dabt _da

t a/ par am folder. These data sets are created when you perform the subsequent steps listed
below. Therefore, ignore these errors and proceed further.

Opentheal | _ca_data_i nserts. sas macro. This macro is located in the following

folder:
<SAS configuration path>/Levl/ SASApp/ SASEnvi r onnment /
SASCf f er Opt For CormSer ver 5. 2/ SASCode/ i nsertscripts

Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.

b. Specify the value, DABT_ADM, for the SCHEMA parameter.
c. Specify the appropriate value for the PATH parameter.

d. Specify the value of the DABTDATA_ROQOT parameter. You can get this value from the

<SAS configuration
pat h>/ Levl/ SASApp/ SASEnvi r onnment / SASOF f er Opt For CormBer ver 5. 2/ SASC

ode/ aut o_decl ar e. sas file.
e. Specify the password for the DABT_ADM schema in the procedure block and also
change the pwfile path according to your environment.
proc pwencode in="BPPEXEC out=pwiile;
run;

f. Specify the <SAS confi gurati on path>/Levl/ SASApp/
SASEnvi r onnment / SASOF f er Opt For CommSer ver 5. 2/ SASCode/ i nsertscripts

value for the scripts_root parameter.
Click Save.
Click Run.
To ensure successful execution of the INSERT scripts, select View = Log on the menu.

Close Base SAS.
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Step 3: Instructions for SAS Offer Optimization for Communications
Application
This section explains the post-installation instructions for the SAS Offer Optimization for
Communications application.

Define Permissions for Data and Logs Folders

You must grant full permissions to the default user, sassrv, who will access the data that is
populated in the Application data mart.

Depending on the operating system of your machine, use appropriate commands to grant all
permissions to the user for the following folders:

<SAS configuration
pat h>/ Levl/ Appl i cati ons/ SASO f er Opt f or CormSer ver 5. 2/ Dat a

<SAS configuration
pat h>/ Levl/ Appl i cati ons/ SASOf f er Opt f or CormBSer ver 5. 2/ Logs

Update and Run INSERT Scripts

The INSERT scripts for the SAS Offer Optimization for Communications application component
insert prerequisite data into some of the tables of the Application data mart.

To update and run insert scripts, complete these steps:

1. Go to the <SAS configuration path>/Levl/ <SAS Application Server context name>
folder.

2. Depending on whether the operating system is Windows or UNIX, run the sas. bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C. / SAS/ Confi g/ Levl/ SASOQOC/ sas. bat file.

3. Opentheal | _ooc_data_i nserts. sas macro. This macro is located in the
<SAS configuration path>/Levl/ SASApp/ SASEnvi r onnent/

SASOF f er Opt For CommSer ver 5. 2/ SASCode/ i nsert scri pts folder.
4. Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.

b. Specify the value, BPPAPTBL, for the SCHEMA parameter.

c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the BPPAPTBL schema in the procedure block and also change
the pwfile path according to your environment.
proc pwencode in='BPPEXEC out=pwfile;
run;

e. Specify the <SAS confi gurati on path>/Levl/ SASApp/ SASEnvi r onment /
SASOf f er Opt For ComrmBer ver 5. 2/ SASCode/ i nsert scri pt s value for the
scripts_root parameter.

5. Click Save.

6. Click Run.
7. Opentheal | _i nf_data_i nserts. sas macro. This macro is located in the following
folder:

<SAS configuration path>/Levl/ SASApp/ SASEnvi r onnent
/ SASCf f er Opt For Conmser ver 5. 2/ SASCode/ i nsertscri pts.
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10.
11.
12.

Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.

b. Specify the value, BPPINF, for the SCHEMA parameter.

c. Specify appropriate values for the PASSWORD and PATH parameters.

Click Save.

Click Run.

To ensure successful execution of the INSERT scripts, on the menu, select View = Log.

Close Base SAS.



Chapter 6 — Validation Instructions

Overview

After you have completed the post-installation instructions, make sure that you validate the
components that you have installed.

Verify the Ul Setup of SAS Offer Optimization for Communications

Make sure that you can successfully log on to SAS Offer Optimization for Communications by

using the sasadm or sasdemo user IDs.

To log on to SAS Offer Optimization for Communications, complete these steps:

1.

2
3
4.
5

In the address field of your browser specify the appropriate URL,
http://<server_host _name>: <server _port >/ SASK f er Opt For Comm For example,
you can enter the URL as http://server0l. abc. com 8080/ SASCF f er Qpt For Conm

In the User name box, enter the user ID as sasadm or sasdemo.
Specify the appropriate password.
Click Log On. The main application window appears.

On Application menu, click Log Off.

Verify the Metadata Layout

To verify that all the required metadata components are created successfully, complete these

steps:

1. Log on to SAS Management Console with a certain profile.

2. Inthe left pane, select the Folders tab.

3. Expand Products > SAS Foundation for Communications and Products > SAS Offer

Optimization for Communications.
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4. Confirm that the following subfolders are created in each of these folders.

+--[ 3 My Folder
[ ] Bllineage
= -] Products
+-[_7] BI Dashboard 4.3
+E| SAS BI Repork Services
=N E| 5435 Foundation for Communications
= D Data Sources
: -7 Cubes
-7 FlatFile
-7 Infomaps
-7 Libraries
-7 Tables
=[] Jobs
[ Cust Trp Job Group
+C| Cerived Fact Job Group
+E| Setup Job Group
+ -[_7] 545 Inteligence Platform
= -[_7] 5A5 Offer Optimization For Communications
= D Data Sources
-7 Flakfile
+C| Libraries
= 7 Tables
= D Jobs
-[_7] Analytics Base Job Group
-7 Bnalytics Scoring Job Group
-] Analytics Setup Job Group
D App Reports Sourcing Job Group
D Customer Associations Job Group
-] Dabt Job Group
Reports
D BPP Performance
-] Business Group Reports Monthly
C| Business Group Reports Weekly
-[_7] Churn Reports Monkhly
-7 Churn Reports Weekly
-[_7] Segmentation Reports Mankhly
C| Seqmentation Reports Weekly
+-[_] Shared Data
+ D Syskem

+ D Isers
5. Close SAS Management Console.

@

BB

+m+m+m+m+m+m+-[?+m+m+m+m+m+
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Validating the Installed Components

Verify the Software Component for SAS Offer Optimization for
Communications

To verify that the software component for SAS Offer Optimization for Communications is created
with the appropriate properties, complete the following steps:

Log on to SAS Management Console with the profile of an administrator.
In the left pane, select the Plug-ins tab.
Expand Application Management > Configuration Manager.

1.

2.

3

4. Locate the Offer Opt for Comm 5.2 component.

5. Right-click Offer Opt for Comm 5.2 and select Properties.
6

On the Connection tab, verify the configuration details. For example, the following
configuration details can be displayed:

¢ Communication Protocol: HTTP

e Host Name: <host name>.apac.sas.com
e Port Number: 8080

e Service: SASOfferOptForComm

7. On the Advanced tab, make sure that the WebApp.ConfigHome property points to the
correct configuration file. For example, the WebApp.ConfigHome property can point to the

configuration file, located at: <SAS confi gurati on path>
/ Levl/ Web/ Appl i cati ons/ SASOF f er Opt For Comrmb. 2/ BPPConf i gur ati on. xm

8. Close SAS Management Console.

Verify Roles and Capabilities

To verify that appropriate roles and capabilities are created, complete the following steps:
1. Log on to SAS Management Console with the profile of an administrator.

2. In the left pane, select the Plug-ins tab.

3. Expand Environment Management and select User Manager.

4

In the right pane, make sure that the following roles or groups are available:

Group Name or Role Name Group or Role
Offer Opt for Comm Analysts Group

Offer Opt for Comm: Administration Role

Offer Opt for Comm: Analysis Role

Offer Opt for Comm: Viewing Role

5. Right-click on any one of the roles and select Properties.

6. On the Capabilities tab, make sure that the capabilities of SAS Offer Optimization for
Communications are defined for this role. Also, confirm that all the role-specific capabilities
are selected.

7. Close SAS Management Console.
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Verify the Stored Processes

To verify that the stored procedures are registered appropriately, complete the following steps:
1. Log on to SAS Management Console with the profile of an administrator.

2. Inthe left pane, select the Folders tab.

3. Expand System > Applications = SAS Offer Optimization for Communications > Offer
Opt for Comm Server 5.2.

4. Select select ooc_stp and in the right pane verify that 27 stored processes are registered.

5. Close SAS Management Console.

Verify the Database Connections

JBOSS

To confirm that the data source is valid, complete the following steps:

1. Go to the <JBOSS_HOVE>/ ser ver/ SASSer ver 11/ depl oy folder.
2. Locate the BPPDat aSour ce- ds. xmi file.

3. Open the file and check if the connection URL tag has the correct entry. For example, the
entry can be <connect i on-

url >jdbc:oracle:thin: @/dbserver0l. abc. com 1521/ <servi ce
nane></ connection-url >

WebSphere

To confirm that the data source is valid, complete the following steps:

1. Log on to WebSphere Admin Console.

2. In the left pane, select Resources > JDBC -> Data sources.

3. In the right pane, select BPPDataSource.

4. Verify the following details:
a. The JNDI name is the same as mentioned in the BPPConfiguration file.

b. Check the URL in the Oracle data source properties. For example, the URL can be
jdbc:oracle:thin: @/ dbserver0l. abc. com 1521/ <servi ce name>.

5. Log off from WebSphere Admin Console.

WebLogic

To confirm that the datasource is valid, complete the following steps:

1. Log on to WebLogic Admin Console.

2. In the left pane, select Services = JDBC -> Data sources.

3. In the right pane, select BPPDataSource.

4. Make sure that the JNDI name is the same as mentioned in the BPPConfiguration file.
5

On the Connection Pool tab, verify the URL in the Oracle data source properties. For
example, the URL can be
jdbc:oracle:thin: @/ dbserver01l. abc. com 1521/ <servi ce nane>.

6. Log off from WebLogic Admin Console.
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Verify the Entries in the Autoexec File
To verify that the Autoexec file has valid entries:
1. Goto the <SAS configuration pat h>/ SASApp folder.
2. Open the appser ver _aut oexec. sas file.

3. Make sure that the following entries are available:
% ncl ude "<SAS configuration path>/ SASApp/ bppsrvc_aut oexec. sas";

% ncl ude "<SAS configuration path>/ SASApp/ conf dnsrvc_aut oexec. sas";

Verify the Predefined Libraries

To confirm that the predefined libraries are created appropriately, complete these steps:
1. Log on to SAS Management Console with the profile of an administrator.

2. In the left pane, select the Plug-ins tab.

3. Expand Environment Management - Data Library manager - Libraries.

4

Make sure that the following libraries are created:
=[] Libraties

----- BPPAPTEL

----- BPPINF

----- CFDBASE

----- CFDCONF

----- CFDDIM

----- CFDFACT

----- CFOMISC

----- CFDREF

----- DABT_ADM

----- ERR_LIE

----- ERRCR

----- FMT
----- OOCARD - SASDATA

----- OO ARD - wrsdist
..... QOCARP - wrstemp

----- SHLIE
----- STP Samples

5. Close SAS Management Console.
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Chapter 7 — Installing the First Maintenance Release

Important Note

Make sure that you complete the instructions that are detailed in this chapter only if you are
installing the first maintenance release as an upgrade-in-place.

Perform Prerequisite Tasks

Before you upgrade to the first maintenance release of SAS Offer Optimization for
Communications 5.2, make sure that you complete the tasks that are listed below.

1.

2.
3.

Undeploy all Web applications that are running on SASServerl, SASServer2, and
SASServerll, from the Web server console.

Stop the Web server.
Stop all SAS services.

Run SAS Deployment Wizard

1.

2
3.
4

Start the SAS Deployment Wizard.
Select Install SAS software, and then click Next.
On the Specify SAS Home page, click Next.
Verify the components that are ready for the update. The information about current and new
versions for various components of SAS Offer Optimization for Communications is
displayed.
e SAS Offer Optimization for Communications Mid-tier
e SAS Offer Optimization for Communications Server
¢ SAS Foundation for Communications Server
Click Next and start the installation steps.
After the installation steps are complete, start the configuration steps.

When prompted, specify the correct User ID (sasadm@saspw) and password to connect to the
SAS Metadata server.

Complete the configuration steps.
Click Finish.
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Chapter 8 — Performing Common Tasks

Important Note

Make sure that you complete the instructions that are detailed in this chapter irrespective of
whether you are performing a fresh installation or an upgrade-in-place.

Step 1: Instructions for Foundation Data Mart

Run the DDL Script

To update Foundation data mart tables, complete these steps:

1.

Go to the <SAS configuration path>/Levl/ <SAS Application Server context
name> folder.

Depending on whether the operating system is Windows or UNIX, run the sas. bat or the
sas. sh file respectively. For example, on the Windows machine, run the

C:. / SAS/ Confi g/ Levl/ SASOOC/ sas. bat file.

Open the cf dn_execut e_ddl s_ml. sas macro.
On a Windows computer, this macro is located in the following folder:
<SAS install ati on pat h>/ SASFoundati on/9. 2/ confdnsrv/sasm sc/ddl .

On a UNIX computer, this macro is located in the following folder:
<SAS install ati on path>/ SASFoundati on/9. 2/ m sc/ confdnsrv/ ddl

Enter the appropriate values for the macro parameters.

a. Specify the appropriate value for the FILE_PATH parameter depending on whether the
operating system is Windows or UNIX. For Windows environment, enter this path as
<SAS installation path>/ SASFoundati on/ 9. 2/ conf dnsrv/ sasm sc/ ddl .
For UNIX environment, enter this path as
<SAS install ation path>/ SASFoundati on/9. 2/ m sc/ confdnsrv/ddl.

b. Specify the value, BPPEXEC, for the USER parameter.

c. Specify the appropriate value for the PASSWORD parameter.
d. Specify the appropriate value for the PATH parameter.

Click Run.

To ensure successful execution of the DDL script, select View > Log on the menu.
Close Base SAS.

Import SAS Packages
To import SAS packages, complete these steps:

1.

Open SAS Management Console.

2. Select the Folders tab.
3. Right-click Products and select Import SAS Package.
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4.

In the Import from SAS Package wizard, complete these steps:

a.

e.

Click Browse and select the cf dn_mnet adat a_il. spk file. The path for this file might
differ depending on the operating system of the machine. On a Windows machine, this

file is located in the <SAS i nstal | ati on pat h>/
SASFoundat i on/ 9. 2/ conf dnsr v/ sasm sc/ Confi g/ Depl oynent / Packages

folder.
Click OK.

Click Next until you reach the Summary page. The import process starts when you click
Next on this page.

Note: Before the import process begins, the following warnings are displayed:

WARN - The column "RECHARGE_ARPU" was not found in the target table
"CUST_MTH_SUMMARY _F", it will be added to the table.

WARN - The column "RECHARGE_ARPU" was not found in the target table
"CUST_MTH_SUMMARY_INCR_TMP”, it will be added to the table.

WARN - The column "RECHARGE_ARPU" was not found in the target table
"CUST_PREV_MTH_ARPU_TMP", it will be added to the table.

These warnings indicate that the changes that are mentioned in the message will be applied to the
metadata. Therefore, ignore these warnings and proceed with the import process.

After the import process is complete, a message is displayed to indicate that the package
is imported successfully. Click View Log to see the details of the objects that are
imported.

Click Finish.

Repeat steps 3 and 4 to import the following packages. Make sure that you import the SAS
packages in the order that is mentioned below:

a.

<SAS installation path>/
SASFoundat i on/ 9. 2/ conf dnsrv/ sasni sc/ et | / Packages/ cfdn_j obs_nil. spk

<SAS installation path>/
SASFoundat i on/ 9. 2/ conf dnsrv/ sasni sc/ Conf i g/ Depl oynent / Packages/
cfdn_cubes_ml. spk

<SAS installation path>/
SASFoundat i on/ 9. 2/ conf dnsr v/ sasm sc/ Confi g/ Depl oynent / Packages/
cfdn_i nfomaps_mil. spk

6. Close SAS Management Console.

Update and Run INSERT Script
To update and run the INSERT script, complete these steps:

1.

Go to the <SAS configuration path>/Levl/ <SAS Application Server context nanme>
folder.

Depending on whether the operating system is Windows or UNIX, run the sas. bat or the

sas. sh file respectively. For example, on the Windows machine, run the
C. / SAS/ Confi g/ Levl/ SASOOC/ sas. bat file.

Opentheal | _confdn_data_i nserts_ml. sas macro. This macro is located in the
<SAS configuration path>/Levl/ SASApp/ SASEnvi r onnment /

SASFoundFor Commb. 2/ SASCode/ i nsert scri pts folder.



5
6
7.
8
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Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.
b. Specify the value, MISC, for the SCHEMA parameter.
c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the MISC schema in the procedure block and also change the
pwfile path according to your environment.

proc pwencode i n=' BPPEXEC out=pwfil e;
run;

e Specify the <SAS configuration path>/ Levl/ SASApp/ SASEnvi r onnent/
SASFoundFor Comrb. 2/ SASCode/ i nsert scri pt s value for the SCRIPTS_ROOT
parameter.

Click Save.
Click Run.
To ensure successful execution of the INSERT script, select View = Log on the menu.

Close Base SAS.

Step 2: Instructions for SAS Offer Optimization for Communications
Application

Change Library Definitions in SAS Management Console

In SAS Offer Optimization for Communications, if users run multiple projects at the same time,
then Oracle might display the error message, “ORA-08177: Cannot serialize access for this
transaction.” As a result, the project runs might fail. In order to resolve this problem, you have to
change the library definitions.

To change the library definitions, complete these steps:

SRR

N

8.
9.

Log on to SAS Management Console and connect to a profile.

Select the Plug-ins tab.

Expand Environment Management > Data Library Manager - Libraries.
Right-click the library name, BPPAPTBL, and select Properties.

On the Options tab, click Advanced Options.

On the Locking tab, change the values for Lock type for reading and Lock type for updating
to ROW.

Click OK.
Repeat steps 4 through 7 for all the other libraries that are listed below the Libraries folder.
Close SAS Management Console.

Update and Run DDL Script

To update SAS Offer Optimization for Communications tables, complete these steps:

1.

Go to the <SAS configuration path>/Levl/ <SAS Application Server context
nane> folder.

Depending on whether the operating system is Windows or UNIX, run the sas. bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C:. / SAS/ Confi g/ Levl/ SASApp/ sas. bat file.
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6
7.
8

Open the bpp_updat e_apdm ml. sas macro. This macro is located in the
<SAS install ation pat h>/ SASFoundati on/ 9. 2/ bppsrv/ sasni sc/ ddl folder.

Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.

b. Specify the value, BPPAPTBL, for the SCHEMA parameter.

c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the BPPAPTBL schema in the procedure block and also change
the pwfile path according to your environment.
proc pwencode i n=' BPPEXEC out=pwfil e;
run;

e. Specify the <SAS install ati on path>/ SASFoundation/9. 2/ bppsrv/ sasni sc/ ddl
value for the SCRIPTS_ROOT parameter.

Click Save.

Click Run.

To ensure successful execution of the DDL script, select View - Log on the menu.
Close Base SAS.

Import the SAS Packages

1.
2.
3.

30

Open SAS Management Console.

Select the Folders tab.

To import the SAS package that is created for ETL jobs, complete these steps:

a.

b.

Right-click Products and select Import SAS Package. In the Import from SAS Package
wizard, complete these steps:

Click Browse and select the path of the ca_j obs_iml. spk file. The path for this file
might differ depending on the operating system of the machine. For example, on the
Windows machine, the package is located in the <SAS i nstal | ati on pat h>/
SASFoundat i on/ 9. 2/ bppsrv/ sasm sc/ et | / Packages folder.

Click OK.

Click Next until you reach the Summary page. The import process starts when you click
Next on this page.

Note: Before the import process begins, the following warnings are displayed.

WARN - The column "OFFER_TYPE_CD" was not found in the target table
"PRE_PD_USAGE_RECHARGE_B”, it will be added to the table.

WARN - The column "TOT_PYMNT_METHOD_CNT" was not found in the target
table "PST _PD_CUST_ACCT_SNPSHT_B”, it will be added to the table.

WARN - The column “"TOT_BOUNCED_PYMNT CNT” was not found in the target
table "PST _PD_CUST_ACCT_SNPSHT_B”, it will be added to the table.

WARN - The column "TOT_BOUNCED_PYMNT_AMT" was not found in the target
table "PST_PD_CUST_ACCT_SNPSHT _B”, it will be added to the table.

WARN - The column "BILL_DUE_DT" was not found in the target table
"PST_PD_PAYMENT_DRVD_B”, it will be added to the table.

These warnings indicate that the changes that are mentioned in the message will be applied to the
metadata. Therefore, ignore these warnings and proceed with the import process.
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e. After the import process is complete, a message is displayed to indicate that the package
is imported successfully. Click View Log to see the details of the objects that are
imported.

f. Click Finish.

To import the SAS package file, ooc_r eport s_mil. spk for cross-sell and up-sell reports,

repeat steps from 3a to 3f. On a Windows machine, this file is located in the following folder:
<SAS installation path>/

SASBest Pri cePl anFor Conmruni cati onsM dTi er/ 5. 2/ Confi g/ Depl oynment / Packages.
Close SAS Management Console.

Include Files in Analytics Autoexec File

To include files in the aut oexec file, complete these steps:

1.
2.

7.
8.
9.

Open Base SAS.

Open the aut o_decl ar e. sas file that is located in the following folder:

<SAS configuration
pat h>/ Levl/ SASApp/ SASEnvi r onment / SASOF f er Opt For CormBer ver 5. 2/ SASCode

Append the following statements at the bottom of the code:

% ncl ude "&autoexec_root./cfdn_initialize.sas";
% ncl ude " &aut oexec_root./aut oexec_cm sas";

% ncl ude " &aut oexec_root./aut oexec_fl ex. sas";
Click Save.

Open the cf dn_aut odecl ar e_cr cs. sas file that is located in the following folder:
<SAS configuration
pat h>/ Levl/ SASApp/ SASEnvi r onnment / SASOF f er Opt For CormBer ver 5. 2/ SASCode

Append the following statement at the bottom of the code:
% ncl ude "&cfdn_crcs_autodecl are_path./cfdn_initialization_crcs.sas";
Click Save.

Close Base SAS.
Restart the Object Spawner.

Update and Run INSERT Script for Customer Analytics
To update and run INSERT script, complete these steps:

1.

Go to the <SAS configuration path>/Levl/ <SAS Application Server context nanme>
folder.

Depending on whether the operating system is Windows or UNIX, run the sas. bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C. / SAS/ Confi g/ Levl/ SASApp/ sas. bat file.

Opentheal | _ca_data_i nserts_ml. sas macro. This macro is located in the
<SAS configuration path>/Levl/ SASApp/ SASEnvi r onnment /

SASCf f er Opt For ComrmBer ver 5. 2/ SASCode/ i nsert scri pts folder.
Enter appropriate values for the macro parameters.

a. Specify the value, BPPEXEC, for the USER parameter.

b. Specify the value, BPPAPTBL, for the SCHEMA parameter.

c. Specify the appropriate value for the PATH parameter.
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d. Specify the <SAS configuration path>/Levl/ Applications/
SASCY f er Opt For ConmBer ver 5. 2/ Dat a/ dabt _dat a value for the DABTDATA_ROOT
parameter.

e. Specify the password for the BPPAPTBL schema in the procedure block and also change
the pwfile path according to your environment.

proc pwencode in='"BPPEXEC out=pwfile;
run;

f. Specify the <SAS confi gurati on path>/Levl/ SASApp/ SASEnvi r onment /
SASOf f er Opt For CormBer ver 5. 2/ SASCode/ i nsert scri pts value for the
SCRIPTS_ROOT parameter.

5. Click Save.
6. Click Run.
7. To ensure successful execution of the INSERT script, select View - Log on the menu.
8

Close Base SAS.

Configure Extension Node for Sample SAS Enterprise Miner Models

The following sample SAS Enterprise Miner models are packaged with SAS Offer Optimization
for Communications:

e Customer retention

e Customer segmentation

e Cross-sell and up-sell
You must configure the extension node for these models.
To configure the extension node, complete these steps:

1. Copy the following files to a suitable location on your computer. The subsequent instructions
refer to this location as <Ext ensi on node pat h>.

e Witeback.sas and Witeback macros. sas

These files are available in the <SAS confi gurati on pat h>/ Levl/ SASApp/
SASEnvi r onment / SASOF f er Opt For ConmSer ver 5. 2/ SASMacr o folder.

e Witeback. xm

On a Windows machine, this file is available in the <SAS i nstal | ati on pat h>/
SASFoundat i on/ 9. 2/ bppsr v/ sasni sc/ sanpl eem ner nodel s/ wri t ebacknode

folder.

On a UNIX machine, this file is available in the <SAS i nstal | ati on pat h>/
SASFoundat i on/ 9. 2/ m sc/ bppsr v/ sanpl eem ner nodel s folder.

e Witeback.16.gif and Wit eback. 32. gi f

On a Windows machine, these files are available in the <SAS i nst al | ati on pat h>/
SASFoundat i on/ 9. 2/ bppsr v/ sasni sc/ sanpl eeni ner nodel s/ wri t ebacknode/ i nages

folder.

On a UNIX machines, these files are available in the <SAS i nstal | ati on pat h>/
SASFoundat i on/ 9. 2/ m sc/ bppsr v/ sanpl eem ner nodel s/ / writ ebacknode/ i mages

folder.
2. Open Base SAS.
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In the Explorer window, create a new library.

a. Enter a suitable name for the library.

b. Specify the path where you want to create the library.

c. Click OK.

To create a new catalog, right-click the library name and select New.

a. Inthe New Member Group window, select the Catalog icon and click OK.
b. Enter Writeback and click OK.

Double-click the Writeback catalog.

a. Right-click and select New.

b. Inthe New Entry in <Library name>.Writeback window, select Source Program.
c. Inthe Notepad window, right-click and select File > Open.

d. Selectthe Wit eback. sas file from the <Ext ensi on node pat h>.

e. Close the source code editor. A file with name Unt i t | ed will appear in the Explorer
pane.

f. Right-click this file and select Rename.

g. Enter the filename. The filename must be same as the name of the sas file that is used to
create the source program. For example, rename the file as Wi t eback.

h. Repeat steps 5a to 5g for the Wi t eback_macr os. sas file.
Close Base SAS.

Copy the Writeback catalog from the location in which you created the library to a folder,
which the sashelp library can read.

For example, on a Windows machine, you can copy the catalog in the

<SAS installation path>/ SASFoundati on/ 9. 2/ cor e/ sashel p folder.
On a UNIX machine, you can copy the catalog in the

<SAS install ati on pat h>/SASFoundati on/9. 2/ sashel p folder.

Copy the Wi t eback. xm file from the <Ext ensi on node pat h> location to the
<SAS configuration path>/ Anal yti csPl atforn apps/ Enterpri seM ner/ext folder.

Check whether gi f 16 and gi f 32 folders are available in the <SAS confi gurati on pat h>/
Anal yti csPl at f or mi apps/ Ent er pri seM ner/ ext folder. If these folders are not available,
create them.

Copy the Wi t eback. 16. gi f file from the <Ext ensi on node pat h> location to the
<SAS configuration path>/ Anal yticsPl atfornm apps/ Enterpri seM ner/ext/gifl6

folder.
Rename the Wi t eback. 16. gi f fileto Wi t eback. gi f.

Copy the Wi t eback. 32. gi f file from the <Ext ensi on node pat h> location to the
<SAS configuration path>/ Anal yticsPl atfornm apps/ Enterpri seM ner/ext/gif32

folder.
Rename the Wi t eback. 32. gi f fileto Wi t eback. gi f.
Restart the SAS Analytics Platform Server.
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Run INSERT Script for SAS Offer Optimization for Communications
Interface

To update and run INSERT scripts, complete these steps:

1. Go to the <SAS configuration path>/Levl/ <SAS Application Server context name>
folder.

2. Depending on whether the operating system is Windows or UNIX, run the sas. bat or the
sas. sh file respectively. For example, on the Windows machine, run the
C. / SAS/ Confi g/ Levl/ SASApp/ sas. bat file.

3. Opentheal | _ooc_data_inserts_mil. sas macro. This macro is located in the
<SAS configuration path>/Levl/ SASApp/ SASEnvi r onnment /
SASOF f er Opt For CommSer ver 5. 2/ SASCode/ i nsertscri pts folder.

4. Enter appropriate values for the macro parameters.
a. Specify the value, BPPEXEC, for the USER parameter.
b. Specify the value, BPPAPTBL, for the SCHEMA parameter.
c. Specify the appropriate value for the PATH parameter.

d. Specify the password for the BPPAPTBL schema in the procedure block and also change
the pwfile path according to your environment.

proc pwencode i n=' BPPEXEC out=pwfil e;
run;

e. Specify the <SAS confi gurati on path>/Levl/ SASApp/ SASEnvi r onment /
SASOf f er Opt For ConrmBer ver 5. 2/ SASCode/ i nsert scri pt s value for the
SCRIPTS_ROOT parameter.

5. Click Save.

6. Click Run.

7. To ensure successful execution of the INSERT scripts, select View = Log on the menu.
8.

Close Base SAS.

Perform Administrative Tasks

After you complete the post-installation tasks, you have to perform certain administrative tasks.
For details, see SAS Offer Optimization for Communications: Administrator’s Guide. This document is

available at the following location:
http://support.sas. conlf docunent ati on/onlinedoc/index_offeropt. htm
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Chapter 9 — Unconfiguring SAS Offer Optimization for
Communications

Pre-Unconfiguration Tasks

You must perform the following tasks before you unconfigure SAS Offer Optimization for
Communications:

Delete OLAP Cube Metadata

To delete the OLAP cubes metadata, complete these steps:

Log on to SAS Data Integration Studio and connect to the sasadm profile.

In the left pane, select the Folders tab.

Expand Products > SAS Foundation for Communications - Data Sources - Cubes.
If a cube is built, right-click the cube and select Maintain - Delete Physical Cube.
Right-click the same cube and select Delete. This step deletes the cube metadata.
Repeat steps 4 and 5 for all the other cubes.

N o ok =

Close SAS Data Integration Studio.

Create a Backup of Metadata Customizations

To create a backup of metadata customizations that you might want to use later, complete these
steps:

1. Logon to SAS Management Console and connect to the sasadm profile.
2. In the left pane, select the Folders tab.

3. Expand Products.
4

Back up the following folders if you have made any customizations that you might want to
save for later use, and then delete the folders:

e SAS Foundation for Communications
e SAS Offer Optimization for Communications

5. Close SAS Management Console.

Create a Backup of Your Configuration Data

Create a backup of the following folders if you want to maintain a copy of your previous data:
<SAS configuration path>/Applications/ SASFoundf or Comb. 2

<SAS configuration path>/Applications/ SASO f er Opt f or CoomSer ver 5. 2

Create a Backup of Your Application Data

Create a backup of your application data that you have maintained in the Oracle database by
using a suitable archival or backup method.
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Removing the Configuration Using SAS Deployment Manager

The Remove Existing Configuration feature of SAS Deployment Manager provides an
automated way to remove the SAS Offer Optimization for Communications configuration from
your environment. However, this feature does not remove the configuration completely. You
have to perform certain manual steps in order to remove the complete configuration.

After you run the Remove Existing Configuration feature, SAS Deployment Manager displays
the summary of components that were successfully unconfigured and also the summary of
components that need to be removed manually.

Post-Unconfiguration Tasks

36

After you use SAS Deployment Manager to unconfigure SAS Foundation for Communications
and SAS Offer Optimization for Communications, perform the following tasks to complete the
unconfiguration process:

1. Restart the Object Spawner.

2. Log on to SAS Management Console and connect to the sasadm profile.
3. In the left pane, select the Folders tab.

4. Expand SAS Folders - Shared Data.
5

Delete <Offer Optimization-Specific Application Server>-OLAP Schema. For example, the
schema name can be OOCApp-OLAP Schema.

o

On the Plug-ins tab, expand Environment Management - Server Manager.

7. Delete <Offer Optimization-Specific Application Server>-OLAP Server. For example, the
server name can be OOCApp-OLAP Server.

8. On the Folders tab, expand SAS Folders > Products.
9. Delete all metadata in the following folders and then delete the folders also:
e SAS Offer Optimization for Communications
¢ SAS Foundation for Communications
10. Close SAS Management Console.
11. Delete the following physical folders:
e <SAS configuration path>/Applications/ SASO f er Opt f or ConmSer ver 5. 2
e <SAS configuration path>/Applications/ SASFoundf or Commb. 2

12. If you also unconfigured the Offer Optimization-Specific Application Server when you

unconfigured SAS Offer Optimization for Communications, then delete the following folder:
<SAS configuration path> <O fer Optim zation-Specific Application Server>.
For example, the folder can be C: / SAS/ Conf i g/ Lev1/ OOCApp.
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